Purpose:
This information is provided to guide ESSENCE monitoring activities and optimize the use of ESSENCE in disease surveillance activities at the local unit level.
<table>
<thead>
<tr>
<th>TOPIC</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>3</td>
</tr>
<tr>
<td>Local DoN MTF Public Health Personnel can use ESSENCE to</td>
<td>4</td>
</tr>
<tr>
<td>Establishing and ESSENCE Account</td>
<td>5</td>
</tr>
<tr>
<td>Initial set-up of an ESSENCE Account</td>
<td>5</td>
</tr>
<tr>
<td>Monitoring Reportable Medical Events</td>
<td>6</td>
</tr>
<tr>
<td>Running the Query</td>
<td>6</td>
</tr>
<tr>
<td>Reviewing the Query Results</td>
<td>6</td>
</tr>
<tr>
<td>Evaluating the Query Results</td>
<td>7</td>
</tr>
<tr>
<td>Monitoring the Alert List</td>
<td>8</td>
</tr>
<tr>
<td>Creating a List of Alerts</td>
<td>9</td>
</tr>
<tr>
<td>Figure 1: ESSENCE Screen Shots demonstrating Regional Alerts and how to further explore the data.</td>
<td>9</td>
</tr>
<tr>
<td>Understanding Denominators</td>
<td>12</td>
</tr>
<tr>
<td>Reviewing and Interpreting Alerts</td>
<td>12</td>
</tr>
<tr>
<td>Figure 2: ESSENCE Screen Shots demonstrating how to perform a Data Query and further explore the data.</td>
<td>13</td>
</tr>
<tr>
<td>Creating Specific Searches</td>
<td>16</td>
</tr>
<tr>
<td>Copying Graphs and Tables from ESSENCE into a Word Document</td>
<td>16</td>
</tr>
</tbody>
</table>
Monitoring ESSENCE Alerts at Navy Military Treatment Facilities (MTFs)

Background

The Electronic Surveillance System for the Early Notification of Community-based Epidemics (ESSENCE) was jointly developed by the Walter Reed Army Institute of Research, the Department of Defense Global Emerging Infections System and the Johns Hopkins University Applied Physics Laboratory. ESSENCE is a syndromic surveillance system for capturing and organizing clinical data from the Military Health System (MHS), including outpatient clinical visits, pharmacy transactions, and laboratory orders, into disease syndrome groupings intended to promote early detection of disease outbreaks. The current iteration of ESSENCE (ESSENCE IV) is maintained by the Defense Health Service Systems (DHSS) of the Military Health System.

Outbreaks in the Navy and Marine Corps typically have been recognized either based on accumulated case reports of reportable diseases or by astute clinicians and laboratories who alert public health officials about clusters of diseases. Concerns regarding emerging disease threats have driven the development of surveillance systems focused on early detection of possible outbreaks and clusters. Such systems provide visibility to electronic data more rapidly than traditional means. Local public health personnel may use ESSENCE for event recognition and monitoring (disease outbreaks or problematic trends, to include repeated miscoding), to identify and follow cases of particular reportable medical events, and to understand the burden on the local health care system.

Per Health Affairs Policy 07-001 (17 JAN 2007) and BUMEDINST 6220.12B (12 FEB 2009), each medical treatment facility (MTF) is to maintain an effective command medical surveillance program. ESSENCE monitoring is to be incorporated into routine medical surveillance activities to include subordinate health care facilities (either centrally or at each location). To accomplish this, each MTF must have at least two ESSENCE monitors tracking the occurrence of alerts in their population, one primary monitor and one alternate. Monitoring of ESSENCE is to occur routinely, but may increase to include weekends and holidays in periods of increased threat (such as specific local terrorist threat, World Health Organization (WHO)/national pandemic influenza alert phase 5 or 6, etc). By monitoring ESSENCE routinely, MTF personnel will better understand the current burden of reportable diseases in their population, as well as detect potential outbreak situations. Taking into consideration the strengths and limitations of ESSENCE, this document provides guidance for Department of Navy (DoN) MTF personnel to make effective use of the system in facilitating their established daily surveillance activities.
Local DoN MTF Public Health Personnel can use ESSENCE to:

- Monitor events and alerts of local significance. Significant events may include clusters that appear to involve more than one subordinate clinic/MTF or a prolonged outbreak that doesn't seem to be resolving.
- Identify, investigate and report reportable medical events. Given the inherent limitations of physician reporting for such events, ESSENCE can be a valuable tool in identifying potential reportable events.
- Remain aware of increases/changes in communicable disease(s) at the MTF or subordinate clinics with the potential to spread to other MTFs in the geographical area.
- Document understanding of regional trends, populations (describe the population(s) under surveillance), and variances over time (seasonal events, such as increases/decreases in population(s), increases in influenza, norovirus gastroenteritis, and other infectious respiratory agents).
  - Local MTF Standard Operating Procedures (SOP) should include data on special populations (such as training commands, schools, etc.), trends seen when groups redeploy, and any other events or circumstances that occur regularly within their population(s) that could affect ESSENCE alerts (such as populations changing with incoming classes at training areas).

Any trends or events considered significant should be communicated to the appropriate groups following Appendix D to Enclosure (1) of BUMEDINST 6220.12B (12 FEB 2009), Navy Medicine Notification Chain.

ESSENCE uses alert generating statistical algorithms in order to identify trends that may be of concern. ESSENCE runs tests of significance for each MTF and each syndrome to determine whether current observed syndromic counts are elevated as compared to expected counts (based on past data for that MTF and syndrome). When counts are significantly elevated, ESSENCE produces flags to direct system users to a possible outbreak in the corresponding syndrome group at the indicated facility.

An ESSENCE alert may be useful for triggering early investigation of possible important medical events (especially in a high threat environment) but not necessarily mean that a local action level has been met or that a true outbreak exists. Conversely, lack of an ESSENCE alert does not necessarily indicate the absence of a health threat. Knowledge of local, and regional, trends, populations, and variances over time is needed to make judgment decisions using the available data. ESSENCE should therefore be employed along with other surveillance activities to support investigative decisions.

Further information related to ESSENCE data management can be accessed by selecting the “References” tab at the top of the ESSENCE page (the main drop down menus), and then selecting “Detector Alogthrims.” A “User Guide” and “Training” (Power Point presentation) can also be found under the “References” tab. A good reference which describes the strengths and weaknesses of syndromic surveillance systems such as ESSENCE is the article “Framework for Evaluating Public Health Surveillance Systems for Early Detection of Outbreaks,” Morbidity and Mortality Weekly Review, May 7, 2004 / 53(RR05); 1-11. http://www.cdc.gov/mmwr/PDF/rr/rr5305.pdf
The two features of primary interest in ESSENCE are the Reportable Medical Events query based on SADR ICD-9 codes, and the alert lists for syndromic categories. The following sections provide the information needed for users to make the most of their time on ESSENCE.

Establishing an ESSENCE account

ESSENCE is administered by DHSS and access to ESSENCE is available through the following site: https://eids.ha.osd.mil/. Two levels of ESSENCE access are possible: Level 1 access is limited to deidentified information; Level 2 access allows the user to obtain personally identifiable information related to medical events of interest. Level 2 access is recommended for local monitoring at the MTF and/or subordinate clinics to allow for identification and further investigation (as needed) of specific patients using CHCS, AHLTA, and other clinical tracking systems.

Initial set-up of an ESSENCE account

Determine the area for which you are responsible to monitor. Some parent MTFs may monitor ESSENCE for their subordinate clinics while others will have ESSENCE users at the parent MTF and the subordinate clinics monitoring their own populations. ESSENCE currently offers a clinic-specific selection; you must create a user-defined site if monitoring more than one clinic/MTF (“Local AOR”). This user-defined site will then serve as the default site selection for all monitoring activities at a parent MTF and its subordinate clinics. The following steps are necessary in order to define the “Local AOR” site:

1. Log in to ESSENCE.
2. Across the top toolbar in ESSENCE, select the tab that reads “Site selection.”
3. Scroll to the bottom and select “user define site selection editor.”
4. Select “New.”
5. Select “Lookup MTF.”
6. Under “Service” choose “Navy”; leave all other options as is and click the “search” button.
7. Select all MTFs that appear in this list that are in your AOR.
8. Once these MTFs/clinics appear in the box on the main page, name the selection “Local AOR.”
9. Save the “Local AOR” selection.

ESSENCE has a feature which emails users when a particular MTF reaches a red or yellow alert level (alerts are described below.) As a local monitor, you may choose to receive these alerts. This is a useful feature for the user who knows the local population and understands how ESSENCE syndromes can be used to monitor that population. Until this level of understanding is reached, you should not rely solely on this feature and should continue to log into ESSENCE regularly. It is important to note that the utility of ESSENCE may differ by MTF and by syndrome. Also note that skilled users who employ the alert email feature will still need to log in to ESSENCE to review alerts in depth.
Monitoring Reportable Medical Events

This function in ESSENCE lists potential reportable medical events based on clinical encounter data (SADR ICD-9 codes). As an MTF monitor, you will use the query function to review the reportable medical event list based on SADR ICD-9 codings at all Navy MTFs within your AOR. Create the query to include all patients seen at a Navy MTF over a particular period of time. At least a one month window is recommended. Not all ESSENCE identified events are true reportable events. Use the following guidelines to assist with determining whether an event is real and should be investigated/reported.

Running the Query

1. Select “Query” from the top toolbar in ESSENCE.
2. Scroll to the bottom and find “User defined site selection.” In this box select “Local AOR” which was created following the steps earlier in this document. If only one MTF is monitored, select that MTF.
3. Under “Select data source” choose SADR.
4. On the next screen leave “Local AOR” highlighted and select the category “Reportable diseases” and submit.
5. Leave all variables on the next screen as is, except for the date range. Review reportable events regularly to limit the time range monitored each day. Typically, a one-month window is recommended (the default is a three-month window). Change the time window to reflect the date range chosen (i.e. one month prior to the current date) and submit.

Reviewing the Query Results

For the typical reportable medical event line listing:

1. Visually scan the last 2-3 days of reports and look for any conditions of particular interest (defined below) keeping in mind the interests at the local level, regional level, and higher headquarters level.
2. The PIN is a unique identifier for each patient. Using this PIN, it is possible to follow a person over time for a particular event and to separate recurring medical attention for one patient from new diagnoses in additional patients.
3. For events which may be of interest (rare events, events of special importance, or large numbers of events) review the additional details. For example:
   a. Does the age(s) of the patient(s) make sense based on the disease type?
   b. Are 10 reports of one disease the same person receiving continued treatment?
4. Once particular events are identified, sort the data by ICD-9 code. Locate those events within the table and look to see if there are additional events, particularly any at the same (or nearby) MTF and/or at the same time.
Evaluating the Query Results

To help understand ESSENCE output, keep in mind that the data are based on outpatient ICD9 codes entered into the patient’s health record and may include rule-out diagnoses, miscoded vaccinations and/or treatments, miscoded medical history, etc. Several diagnoses are known to be frequently miscoded, including:

- Pulmonary (or other) tuberculosis (often represents screening or latent infection)
- In general, vaccine preventable diseases – vaccination is often miscoded as disease. Examples include:
  1. Anthrax
  2. Smallpox
  3. Japanese Encephalitis
  4. Meningitis – Meningococcus (if in clusters)
  5. Polio
  6. Typhoid
  7. Yellow Fever
  8. Rabies

If these events occur often in your review of ESSENCE, it is safe to assume that when seen, particularly in clusters, it is extremely unlikely that they represent true cases. Therefore, ESSENCE may not be useful in identifying true cases of these specific diseases.

Additional diagnoses may also not represent true reportable events (and rather represent miscoding, rule-out, etc.) but our experience shows that they have a higher likelihood than the above events of representing true cases. These include:

- Malaria
- Varicella (may include vaccinations; review data to see if all ‘cases’ are seen by the same provider, which increases the probability that the ‘cases’ merely represent vaccinations).
- Measles
- Mumps
- Leishmaniasis
- Leprosy
- Leptospirosis

The following events should be considered important and should be tracked for potential follow-up:

- Dengue Fever
- Meningococcal Meningitis (if not in clusters)
- Q Fever
- Any other conditions that are rare or unusual (keep in mind medical events that are reportable within 24 hours) and do not have a vaccine associated with prevention of the disease.
• A cluster of the same medical event with higher numbers of cases than routinely seen, particularly if they are seen in different MTFs in a given geographic area.

Investigation of unusual findings to determine real events includes reviewing the Navy Disease Reporting System internet (NDRSi) for a Medical Event Report (MER) on the finding. It is also important to follow the event (look for the same PIN(s), patient identification number) over several days in ESSENCE to determine if it keeps appearing (for example, if someone really does have dengue fever, they would continue to show up in the medical events module of ESSENCE over a number of days as they received treatment).

Monitors should maintain a list of events for which ESSENCE is useful in identifying true cases. Note that some events are significant only in specific contexts. For example, a mumps event in ESSENCE in an active duty member vice an infant or recruit is more likely to represent a true case of mumps as opposed to a miscoded vaccination event. An influenza case in the summer may represent a concerning trend as opposed to the case diagnosed in the winter. All of these factors (age, beneficiary category, time, and geography) should be taken into account when evaluating events.

Always ask yourself, “Do the data make sense?” For example, 120 cases of disease X in one day when the baseline is only 2 is most likely miscoding. A large one-day spike in which all visits have the same illness coded may represent a miscoding during a mass vaccination, screening, or prophylaxis administration where the event was miscoded for the disease as opposed to the preventive measure (i.e. miscoded for “disease X” as opposed to “vaccination for disease X”).

Knowledge of your providers and clinics can assist in determining miscoding episodes. It can not be stressed enough that knowledge of your facility, providers, and way of doing business in addition to knowledge of local and regional, trends, populations, and variances over time, is needed to make judgment decisions on the data being presented. When miscoding errors are found, it is an opportunity to educate clinic staff on proper code to use, thereby improving the usefulness of ESSENCE in the future.

Finally, when there are current public health issues of interest, additional events may be added to the daily monitoring activities. For example, ESSENCE could be used to monitor foodborne illnesses that cross state borders, such as the 2008 salmonella outbreak.

**Monitoring Alert List**

This function in ESSENCE is based on syndromic surveillance; various ICD-9 codes are mapped to syndromes for monitoring purposes. ESSENCE uses complex algorithms to estimate an expected number of events in each syndrome category for a given day and MTF, based on historical data. Actual counts of ICD-9 codes in a particular syndrome each day are compared to the expected number and alerts are generated when the observed number exceeds the expected number by a significant (red alert) or marginally significant (yellow alert) amount. A list of alerts is generated. There are several types of alert lists that can be viewed in ESSENCE; SADR ICD9 codes are currently the most useful and will be the focus of this section.
Creating a List of Alerts

Use the alert lists to look for syndromic alerts across all Navy MTFs in your AOR. It is also useful to review alerts across other MTFs, either within the geographic area (Air Force and Army MTFs) or across other Navy MTFs, in order to gain an understanding of how the trends compare within your AOR and beyond. Screen shots follow the step by step guidance below.

1. Select “Alerts” from the top toolbar in ESSENCE.
2. Scroll to the bottom and find “User defined site selection.” In this box select “Local AOR” which was created following the steps outlined earlier in this document, (or ensure your individual MTF is selected) and enter.
3. The default list of alerts is based on “SADR temporal” and will likely be the alerts most frequently monitored at the MTF.
4. The first table that appears under the alert list will be alerts that are significant within the MTF’s AOR. These are generally rare and may be difficult to interpret due to small numbers. If a known public health situation exists across a broad geographic area it may be more useful to monitor these alerts at that time.
5. The second table on the alerts page includes the MTF-specific alerts.
6. Once you identify an alert for further investigation, you can drill down to that MTF and syndrome and get a listing of the observed and expected counts at that site over a specified period of time. To do this:
   a. On the far right side of the table under the “Links” column, click on “Time Series.” This will produce a time series graph, followed by an alert data table showing the data for an approximately 3 month period.
   b. To further drill down on a day of interest, on the far right side of the table under the “Links” column, click on “Data Details.” This will give a breakdown by ICD-9 code, patient, clinic, and provider, along with information on age and status (active duty, family member, etc.). Note: To see actual patient identifying information, you need Level 2 access in ESSENCE.
7. Finally, you can drill down to the particular cases for a syndrome at an MTF on a particular day. With Level 2 access, there are additional case details/PHI which may be useful in understanding the disease burden.

Alerts that are of concern or raise suspicion should be further investigated using the “Time Series” links. The default for these graphs will be the previous 3 months data for the selected syndrome. If data for a longer period of time are required (looking at the previous 12-18 months of data can be helpful for determining seasonal and/or recruit/training population variation), expand the “Configuration” box above the time series graph by clicking the + sign next to “Configuration.” In the box that pops up, the date range for the time series graph may be changed (along with other demographics). When done with your changes, click the “Change Configuration” button at the bottom of the box. A new time series graph will appear.

**Figure 1**: ESSENCE Screen Shots demonstrating Regional Alerts and how to further explore the data.
Regional Alert. On this day, there was an increase in GI Syndrome across the geographical area.

“Site” monitored. It is helpful to see what other clinics in your geographical area are experiencing (to include other services).

To further explore BMC Little Creek, click on “Time Series.”

Clicking on “Time Series” will bring up the graph and table seen below.

Graph (from clicking on “Time Series”) showing GI Syndrome visit counts for past 3 months for MTF of interest (example, BMC Little Creek).
Data Table for BMC Little Creek showing GI Syndrome visit counts for each day of the past 3 months. Clicking on “Data Details” will provide more information for the day in question.

If you have Level 2 access, you can click on hyperlinked “PIN” (Patient Identification Number) and obtain individual patient demographics. “Data Details” view. Provides information on each visit seen for day in question for GI Syndrome.
Understanding Denominators

Although ESSENCE uses sophisticated algorithms to determine the ‘expected’ number of cases in each syndromic class, these algorithms largely rely on the previous two weeks data and do not incorporate all external factors. Therefore, the local monitor should have awareness of population changes (i.e. redeployments, training cycles, etc) which may impact the expected number of events.

For example, beginning in early July 2008, BMC Annapolis had daily yellow or red alerts for ILI, Fever, and Respiratory syndromic categories. The time series graph of these data appeared to indicate a substantial increase in these events. However, consider the timing of these reports within the calendar year: new classes of plebes enter the Naval Academy each July increasing the number of people on campus as well as introducing new pathogens to the campus. As such, these alerts may be considered expected. Comparison with previous years’ rates of ILI, Fever, and Respiratory syndromic categories for the same period showed the same increases.

Reviewing and Interpreting Alerts

1. Visually scan the alert list to identify those sites that have a very high number of observed cases as it may be easier to identify a trend with more cases. Some syndromes generate alerts based on small counts making it difficult to understand whether trends are medically significant or not. The following provides some suggestions for further investigation (note that these are meant to be a rough guideline, not a strict formula!):
   a. 1-3 cases – difficult to interpret.
   b. 4-30 cases – still difficult to interpret, particularly at a large MTF, but if the case count remains elevated over several days and the expected number is very low, it may suggest a true event. Also consider the geography of the MTF and any external factors that may influence the count (such as a group redeploying or a new class at a training command).
   c. 31+ cases – look at the time series graph and consider monitoring this MTF over several days.

2. Also look for instances where a particular MTF seems to be on the alert list for several days. A single case may keep an MTF on the alert list, but multiple elevated alerts may indicate a true outbreak.
3. Consider external factors which may influence disease burden when evaluating these data, such as known outbreaks in a particular area.

4. When an alert raises suspicion, keep the following in mind:
   a. Could the alert be due to seasonal variation? Compare with background rates (see 5. below) to see if the trend is increasing over time, and/or is the count obviously higher than the previous several weeks. Is the count higher than for the same time period the previous year?
   b. Look at incident visits versus total visits – are the visits repeat visits or new visits?
   c. Look for a ‘saw tooth’ pattern. Many outpatient clinics tend to see more patients at the beginning of the week, with fewer as the week progresses. This pattern is more apparent in the higher count syndromes, such as respiratory, influenza-like illness, and gastrointestinal, but can appear in other syndromes.
   d. Look at the “Data Details” link to see the exact ICD-9 codes, clinic, and provider. If a provider is using a particular code more often than usual, an alert can be triggered. Calling the clinic or provider will help to determine if it is a real alert, or potential coding error.

5. To further consider an alert (to determine if it is a ‘normal’ seasonal peak for the facility, or potentially something unusual), construct a time series graph on the alert (syndrome or reportable medical event of interest) for the MTF by (screen shots follow the step by step guidance below):
   a. Click on “Site Selection” from the top banner.
   b. Next go to “System Defined Site Selection.” From this drop down menu pick the state or area the MTF(s) of interest is located in.
   c. An alert list for the location will appear. Click on “Query” from this page, located in the top banner.
   d. Click “Submit” on the next screen.
   e. This screen will allow you to pick the specific MTF (or multiple ones in the same area by holding down the CTRL button while clicking to highlight in the drop down menu). You will also, from another drop down menu, select either syndromes (default) or reportable diseases. Click “Submit.”
   f. You will now pick the date range you want to look at, along with the demographics. You will also pick the syndrome of interest (you can only look at one syndrome at a time). Click “Submit.”
   g. These steps will produce a time series graph, along with a data table. Additional information on specific days is obtained on the far right side of the table under the “Links” column, by clicking on “Data Details.”

6. If still uncertain about an alert, contact the clinic and/or provider the majority of cases are coming from for additional information. If contacting the clinic or provider does not clarify the situation (i.e., alert was caused by miscoding), and/or additional help is needed, contact the Threat Assessment Group of your cognizant Navy Environmental and Preventive Medicine Unit (NEPMU). Contact information for the Threat Assessment Groups can be found in Enclosure (2) of BUMEDINST 6220.12B.

**Figure 2**: ESSENCE Screen Shots demonstrating how to perform a Data Query and further explore the data.
“Data Query” screen for example “Site” of interest.

This drop down menu allows you to choose “Syndromes” or “Reportable Medical Events” (diseases).

Demographic selection screen. A 15 month period has been selected to look at our syndrome of interest (GI) over time.
Graph produced from “Query,” showing the visit count for GI Syndrome over past 15 months for geographical area of interest.

“Data Table” showing daily information on visit counts for above graph.

Clicking on “Data Details” would provide further information on the actual visits seen on that day in GI Syndrome.

Alerts can be difficult to interpret as the algorithm for alerts often identifies yellow or red alerts based on a single case. For example, if the expected number of events in the ‘hemorrhagic’
category for a particular day is 0.12 and 1 case was observed, it remains likely that the single case does not represent a signal worth investigating. Any rare event will trigger an alert with a single case. Further complicating the issue is overlap between the different syndromic categories, such as ILI and Respiratory (they contain several of the same ICD-9 codes).

Creating Specific Searches

Queries for specific diseases, laboratory orders, or radiology orders can also be constructed. These may prove useful in further interpreting whether a reportable medical event or an alert is in need of further investigation.

1. Select “Preferences” from the top toolbar in ESSENCE. Under “Preferences” select “User-Defines Syndromes.”
2. In the next screen, click on “New” (upper left side). Pick the data source you are interested in searching – SADR ICD codes, GC3 codes, laboratory orders CPT codes, or radiology orders CPT codes. Note: you need to know the code or family of the code you are interested in.
3. Type the code you are interested in into the “Code” area of the pop-up window and click “Search.” The code and any related codes/sub-codes appear. Click on the code(s) you are interested in, then click “Select.”
4. Name your defined syndrome in the box on the upper left side; select the code in the central box, then click “Save.”

To run your user defined syndrome search:

1. Select “Query” from the top toolbar in ESSENCE. In the next screen, select the data source you used to create your query (SADR ICD codes, laboratory orders, etc.) and then click “Submit.”
2. In the next screen, select the MTF you wish to run the query on (all Navy MTFs will be displayed in the drop-down menu along with any user defined sites, such as Local AOR).
3. In the “Select Category Area” select “Syndromes” and click “Submit.” The next screen will have a “Next Selections” box. Go to “Syndromes,” expand the drop-down menu and select your user defined syndrome. Select other demographics based on what you want to look at. Click “Submit.”
4. A time series graph along with a data table will be displayed. The data from the table may be downloaded into Excel for further manipulation.

Copying Graphs and Tables from ESSENCE into a Word Document

Any table in ESSENCE may be copied and pasted into a Word document or email by highlighting the table, copying it, and pasting it into the desired location. Graphs can be moved by:

1. Open up the Paint program (Start menu, Programs, Accessories, and then Paint).
2. Center on the screen the graph you want to copy.
3. Hit the “Print Screen” button on the keyboard.
4. Open Paint window and click on “Paste” under the “Edit” dropdown menu.
5. The graph is now pasted in Paint. Its size can be adjusted by adjusting the margins in Paint.
6. Under the “Edit” dropdown menu, click on “Copy.” You can now paste the graph into a Word document.